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Pl System Analytics — Fit for Purpose

ABSTRACT

Attend this talk as we cover scenarios to illustrate the different levels of
analytics that are fit-for-purpose when using the Pl System - for example,
what calculations and analysis do you do in AF, when do you use MATLAB
for advanced calculations that hook into AF and when do you call on “data
science and machine learning ”.

Use cases will focus on equipment i.e. pump or motor or compressor etc. as
well as on a process.

7 oslsoft
- Pl\World sarceLona 2018 #PIWorld  ©2018 OSlsoft, LLC



Layers of Analytics — View Thru’ Multiple Lenses

- Functional Scope - Process Insight & Excellence
» Descriptive, diagnostic, predictive, prescriptive

- Business Scope - Improved Reliability

» Usage-based Maintenance - UbM
* Condition-based Maintenance - CbM

» Predictive Maintenance — PdM
» Simple predictive (Advanced CbM)
» Advanced predictive - Statistical, Machine learning...

tural Location
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Layers of Analytics - Process Operations

A S—
T
/Howcanwe
'\\make it happen? /
} \ D /T Prescriptive
| What wil Jlll Analytics )
\_happen? / : -“ON
— . :""" 1A
Y NS
:"""Why did it Q’V" Predictive of 5‘6\“
. ““\__happEﬂ? Ana:ytu:s fORE
= P ’ ‘
<>; /" What \ % Diagnostic
\\happe nef‘j’?/ J Anal?ftlcs ‘“5‘6“1
Descriptive
Analytics
@Aﬂo\\‘ HIND
NFOF
/ Traditional BI | Advanced Analytics >
Source: Gartner DIFFICULTY

0OSlsoft.
- P|W0r|d BARCELONA 2018 #PIWorld  ©2018 OSlsoft, LLC



S a—— s/ /A
Layers of Analytics - Maintenance & Reliability

EffectiAveness Predictive
Simple
Advanced (Machine
Learning)
Condition-based

Continuous
Automated Readings
Instrumented  Aytomated Analysis

Automated Readings
Operator Rounds | Ivsi 0 am 5
Manual Readings ManuslARalySIS Pl'edICtIVG malntenance

Manual Analysis
Preventative

Calendar-based
Runtime-based

Efficiency

Condition based
maintenance

Reactive

“Break-Fix”
Run-to-failure

Usage based maintenance
(UbM)
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Layers of Analytics — View Thru’ Multiple Lenses

 Functional Scope - Process Insight & Excellence
« Descriptive, diagnostic, predictive, prescriptive

. Architectural'Location
» Edge device, Server or cloud
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ure calculations for
sparency and scale

ath, statistical, and time-
based functions

* Integration with MATLAB

« Testing and operationalization
of predictive analysis models

« Condition-based notification

« Supports future data for
forecasting

OSlsoft.
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Heat Duty. Q=q, + a
Qs = Wx Cpn X(Ti- T5)/1000/3600
Qs W X Cpe X (to-1;)/1000/3600
Hot Fluid Pressure Drop. APn = P; — P,

Cold fluid pressure drop. AP¢ = p;i- po

Temperature range hot fluid. AT = T;- T,

Temperature range cold fluid. At =t, — t;

Capacity ratio. R=W x Cpn / W X Cpc (or) (Ti- To) / (to- ti)

Effectiveness. S = (to- ) / (T, — t;)

LMTD
LMTD Counter cwrrent Flow = ((Ti=to) — (To=1:)) / In ((Ti=te)/(To=t))
LMTD Co curent Flow = ((Ti-t)) — (Toto)) / In ((Ti-t)/(To-1e))
Correction factor for LMTD to account for Cross flow
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Diagnostic Analytics — Trending and Event Awareness

* Access to operational data in
real-time with tools suited to
Operations.

econdary Transformer

Voltage

Light Vac Gas Oil
97.08

* Supports ad hoc, self-service

Hoavy Vac Gas Oil

investigation.

Vacuum Resid
2212

Total VARh Total Wh

CLEBFP1

Outside Air Temperature Main Steam F
25.634 deg F 20.174 Kk Ib/hr

X

oosezesmis  Active Thrust

Metal
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Real-time Data is Different

. A% leakno - A% compute_0002 - a8 ci - A% read_locat - F. map - A% plat - A% block - A% date_reptd -
. . 7800201621 00201621 San Jose Under Drway o/m 11/28/2000 14:00:00
o T ransa Ct| ona I d ata IS 3l 7501200081 01200081 Santa Clara ofm in s/ cor of Humbolt Ave 1/5/2001 11.00:00
3l 7201200091 01200091 Santa Clara ofm 2' into property 1/4/2001 01:30:00
.
reco rd e d in ata b u | ar P 7501200171 01200171 Sants Clara ofm, 3 from sidewslk 1/16/2001 1000:00
73 7801200841 01200841 Santa Clara 1% o/m under concrete pkstrip at e/end of drway 8/27/2001 11:00:00
fo r m at W i t h Va | u e S 7801200851 01200851 Santa Clara 1% under drway at curb & Gutter £/28/2001 10:00:00
[ 7803200121 03200121 San Jose 1575 Parkveiw Ave. 3/23/2003 09:48:00
. t d b | |3 7803200461 03200461 Santa Clara 1% in svc tee area ofmain 11/10/2003 07:33:00
a SS o C I a e y CO u I I l n S PIl 7806200241 06200241 Santa Clara s/w cor Princeton Wy x Princeton Ct on main 2/6/2006 13:15:00
. 7806200271 lﬁll}ﬂz?l Santa Clara S/E cor Homestead x Lawrence Exwy valve frme&cover 2[7/2006 11:40:00
I n e a C h roW ° 7806200351 06200351 Santa Clara O/M @ svc tee (Longside) 2/16/2006 10:00:00
7806200441 06200441 Santa Clara ‘OVer main next to srvc tee 3/8/2006 13:00:00
7806200481 06200481 Santa Clara ‘on main or tee 3/10/2006 09:45:00
LNl 7E065200491 06200491 Santa Clara ‘on main ovr sewer not venting to house 3/10/2006 10:00:00
° R e a | _ti m e d ata is 7806200501 06200501 Santa Clara btwn #s 3145 & 3155 Mauricia Wy on main or tee 3/10/2006 11:25:00
7806200511 06200511 Santa Clara on tee 5/0 driveway 3/10/2006 14:00:00
re CO rd e d With O n I il 7505200541 06200541 Santa Clara ontee 3/15/2006 13:30:00
y 7806200561 06200561 San Jose ‘ovr main btwn Greendale & Auburn on Albany 3/16,/2006 13:45:00
. El 7E065200611 06200611 Santa Clara 15' from drway about 15" in parkstrip @svc tee 3/22/2006 13:45:00
tl I I I e C O n text 9 7806200641 06200641 Santa Clara 3% OVER MAIN NEXT TO SEWER 3/23/2006 14:00:00
. 2 7806200651 06200651 5an Jose ‘On Main or srvc tee 3/24/2006 11:15:00
I ° e ° Va | u e a n d el 7806200681 06200681 Santa Clara 5" in parkstrip fr/swk over tee on main 6' from__. 3/28/2006 13:40:00
7806200701 06200701 Santa Clara 36' EO W p/l Olympus. 2% In water box 3/28/2006 13:00:00
.
tl m e Sta m p . el 7806200711 06200711 Santa Clara F/0 ofmain (under tree) 3/29/2006 11:00:00

7BO6200721 06200721 Santa Clara ‘ofsvc/tee about 3' from drway in parkstrip 3/29/2006 13:10:00

56.902 03-SEP-2016 11:23 AM
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Real-time Data Requires Context

Time

63.781 03-SEP-2016 1119 AM | §) | 56.902 03-SEP-2016 11:23 AM | B | 58.341 03-SEP-2016 11:41 AM
|

Asset BoentifidEdons Location

ton Pains i
L1 ,
Pequannock it §  Orade
- ) Y o0 i ai
| 5 Weyne @ © Foramus
YraaPat pafflson :
U o, \
| Y %WWMM ood
/-rv»'*'j jestPaterson § - © 5 /ade Brobk
Fairfield"s_ DO iackeasack
~titye Falls | P »
J & ® Lodi  § , Bogot
@ Citon Hastirouc Bl
pg,:, North Caldwell ! (1“‘ as! Heights o el
Wkt pedarGrove 2@ Salfington e
\ West Caldwell %) W”d"'d:‘
Verone Rutharfor
E Fi
shbanoverd iy B P ST o therford ,, o
oselan P - Nutey N - U
e Wit Orarge s MERICa ‘) ~ fyranirs "'u{;
nover Glen Ridge S L %3
Livingston ® Y N o forth
A el
k ) West
¢ ® pat
o on
A o
! ark ¢

OSlsoft.

: PI WOI’|C| BARCELONA 2018

#PIWorld  ©2018 OSlsoft, LLC



Real-time Data Requires Context

& Refining
A§set & & Bahrain Process Category: Process Data
Hiera rchy El i Crude Unit Context s m & Cold Side Inlet Temperature 77.1157939501953 °F
EI ﬂ Equipment s B ¥ Cold Side Outlet Temperature | 131,192291259766 °F
------ (3 B-E100 P & Hot Side Inlet Temperature 374.601501464844 °F
i Pl a nt """ ﬁ B-E235 ¥ Hot Side Outlet Temperature 292.926361083934 °F
L () BE345
G- @ KPIs Location
°
Process b @ FCQU
------ [ Gasoline Elender Teimrrae LT
° .
Assets - ﬁ Isomerization [c] Z] Address 2265 W Salinas 5t, San ...
& ﬁ F‘.I;ForEmE_r : B E] Latitude 29,43027
- uipmen
* Process Context EI 5 k;llsm =l Longitude 88518172
. f (J Feed N42A
* Location .. (J Feedrate P
- Reactor Specifications
* Specifications [~ (@ Reformer 2 e
[+~ (G Vacuum Unit = =1 Ares o
B (@ Kuwait
B ﬁ Oman 5] [E] Coeffident 75.66 BTU per F ft2 Hr
H- (§ Qatar S m [E] service Crude vs. Naphtha
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Pl AF Provides Context to Real-time Data

Elements = Transforme
& Elements
[SE8= B ow Voltage System Select Data > Modify View > Publish
[=l- [§ Substations
(F Palmer = Add Column Y Exiit Row Filters = Edit Value Mode S [Eri e
. ﬂ Rockefeler 0 coiumns 0 Raw Filters L’:::?I;ﬁ:r:m-“ TS 12:00:00 AM | | VG 12:00:00 AM | Apply
Bl @ Circuit 03
- G X i TimesSt: Circuit Phase Pole Tr Avg_Voltage Max_Vaoltage Min_Voliage Tot_VARh Tot_Wh | =
Bl (@ PT 812024305 Palmer 11/1/2015 12:00:...  Circuit 01 X PT 411054401 250,151 250.385 249 977 566.962 1,831.385 A
O MR-202515%7 U125 1200 QGO X BLili0sad0l 220,151 250,355 242,917 $65.27 1531140
- g :E'ﬁi:i:i 11/1/2015 12:02-  Circuit 01 X BT 411054401 250152 250385 249 977 566812 1,830 895
" R i
& MR-20251813 5 R T4 ] s BT aTi05a801 230152 peLT R TR0 LI T.850 65
______ R Palmer 11/1/2015 12:04.._ Gircuit 01 X BT 411054401 250152 250385 249,978 566.663 1,830 405
J MR-202518314
- [ MR-20251815 Palmer 11/1/2015 12:05:.._ Circuit 01 X BT 411054401 250152 250385 249,978 566.588 1,830.160
- [ MR-20251816 Palmer 11/1/2015 12:06:.._ Circuit 01 X PT 411054401 250152 250385 249 973 566.513 1,829.915
""" G MR-20251837 Palmer 11112015 1207~ Gircuit 01 X PT 411054401 250152 250,336 249,975 566.439 1,529671
- g :2'3;:3::’: Palmer 11/1/2015 12:08.._ Circuit 01 X BT 411054401 250.152 250386 249,978 566.364 1,829 426
. G MR-20251387 Palmer 11/1/2015 12:09:.._  Circuit 01 X PT 411054401 250152 250386 249 979 566.289 1,829 181
" R Palmer 11/1/2015 12:10:.._ Gircuit 01 X PT 411054401 250153 250386 249,979 566.215 1,528 936
& MR-20251909
e () MR-20251910 Palmer 11/1/2015 12:11-_._ Gircuit 01 X PT 411054401 250153 250386 249,979 566.140 1,828 691
- [ MR-20251911 Palmer 1111/2015 12:12-._ Circuit 01 X PT 411054401 250153 250386 249 979 566.065 1,828 445
- @ :2‘3;;;5 Palmer 11172015 1213 Circuit 01 x PT 411054401  250.153 250.386 249.979 565.991 1,828.201
""" g MR:ZOZSSSS < Palmer 11/1/2015 12:14:._ Gircuit 01 X BT 411054401 250153 250.386 249,980 565.916 1,827 956
-5 MR-20255878 Palmer 11/1/2015 1215 Circuit 01 X BT 411054401 250153 250387 249 980 565841 1827712
. _ almer - . Ircur . .. . N
F MR-20265521 Pal 11/1/2015 12:16:.._ Circuit 01 X PT 411054401 250153 250387 249 980 565.767 1,827 467
J MR-40195576 Palmer 11/1/2015 12:17-.._ Gircuit 01 X PT 411054401 250153 250387 249,980 565692 1,827.222
PT 512111102 Palmer 117112015 12:18-_..Circuit 01 X PT 411054401 250,154 250.387 249980 565.617 1,826,977
Palmer 11/1/2015 12:19..._ Circuit 01 X PT 411054401 250154 250387 249 981 565.543 1,826.732
Palmer 11/1/2015 12220, Gircuit 01 X BT 411054401 250154 250387 249 951 565468 1,526 467
X

Palmer 11172015 12:21:...  Circuit 01

PT 411054401 250.154 250.387 249981 565.393 1,826.242 W
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Real-Time Decision Analysis

Supporting Analytics with Contextualized Data

Time and Event
Trending & Awareness

Specialized Models

Simulation & Optimization

APpp = kh
Q= R
]41.2”Bg{zné —34 S}

Descriptive
Condition & Performance

OSlsoft.
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Retrospective & Predictive Analysis

Pl Integrator for
Business Analytics

Dashboards &
Multidimensional Assessment

o
ood L P
Time, Event and Tabular ¥ SN
Asset Context Context AT T
Predictive
Common Ground between Technological Statistical Modelling
Contexts & Machine Learning
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Diagnostic Analytics — Multidimensional Visualization, Dashboards

Oil and Gas Operations & swre Dasasoare

Totapresbtin v Target ot Ragon e s

B T

= "2 o
—
=
—

Business Analysis
Product inventories

Ml Ditog rrmarce Refioey e

Asset Performance
Benchmarking

OSlsoft.
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Dashboards
Collaboration

Analytics
Measurement
Correlation
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Feed Drying Process - process and Regeneration Cycles
Also see Pl World 2018 Layers of Analytics Hand-on Lab

* Molecular sieve dryers remove
water from hydrocarbon et oo
feedstock before entering
reactor : _ l

Dryer & ==
* Proper regeneration is critical ez T

to avoid corrosion in acidic
reaction

0.3 ppm 9,995 polid

Dried Feed Moisture Dried Feed

e Cyclic operation between
Process and Regeneration oo
Cycles Regeneration

599 bblid

EF B Cutlet Temperature

Regnerant Return
Ll

Haot il Return
177 bolid

* Regeneration cycle is
indicated by high be outlet

temperatures
) 0Slsoft 15
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Predictive Analytics — Dryer Regeneration Guidance for Operations

Dryer Regenerations

* During Regeneration, monitor
bed Outlet Temperature
against a modeled profile,
notify operator of deviations

* Prepare data using AF Analytics
and Event Frames

factor(bRun)
3B 2
46 —128
47 129
54 130
60 131

* Publish dataset for model , - —
development and training i 4/1912018 12:54:00 PM - 4/19/2018 3:54:00 PM &(&%ﬁm&fl

bT

* Develop model in R/MATLAB

* Operationalize model using AF
Analytics and R/MATLAB

200

L L L L 1
0.5h 2.5h
4/19/2018 12:54:00 PM 4/19/2018 3:54:00 PM
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Feed Dryer Status — Regeneration Event Frames

° i i If('Outlet Temperature' »>= 'Outlet Temperature|Start of Regeneration Temperature'
AF Analytic defines the
. . And PrevVal('Operating State', '*-5h') = "Process")
beglnnlng and end of Then (If PrevVal('Operating State', '*')="Regeneration"
regeneration cycle Then Nooutput()
Else "Regeneration")
.. Else
e Digital state for each dryer (If('Outlet Temperature' <= 'Outlet Temperature|End of Regeneration Temperature'
i i And PrevVal('Operating State', '*-5h') = "Regeneration")
with Process of Regeneratlon Then (If PrevVal('Operating State','*') ="Process"
states Then NoOutput()
Else "Process")
« Starttemp.=170 F, Else Nooutput())
End temp = 175 F Dryer Regenerations

* Confirm five hours since last
regeneration to avoid short
cycles caused by initial
temperature fluctuation

*  Backfill through 2017

7 oslsoft
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Feed Dryer Bed Age — “Dryer Bed Processing Age”

° AF EXpreSSIOH ana|ytIC Dryer Bed Condition - Mol Sieve Age
determines processing age of
molecular sieve desiccant

* Enables bed balancing for
maximum service

Dryer B Processing Age

e Calculate Lifetime Total Dried
Feed, converts total volume
from a volumetric rate

* Processing age:

Lifetime Total Dried Feed
Loaded Wt. of Mol. Sieve

If ('Operating State' = "Process"

And Not(BadVal('Process Flow'))

And Not(BadVal(PrevVal('Process Flow','*'))))
Then 'Lifetime Total Dried Feed’ +

TagTot('Process Flow', PreviousProcessFlowTime,"'*")
Else NoOutput()

* Backfill through 2017

7 oSisoit
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Dryer Regeneration — Publishing Summarized Dataset

* Leverage AF model to Select,
Shape and Publish tabular SelectData > Modify View > Publish
VieWS tO a Va riety Of endeintS 4 Source Events % Search Shape + Matches

er Regenerations A OShcurt 3

Server CHERTLERTA50 M| | EventShape . ffpund 52 Matches
° Eve nt VieWS u b I | S h Eve nt Database Dryers ou | * " DwerRegenersion Cyce VR *3 Dryer A Regneration 01-02-17 00:00
p 4 Avg Hot Oil Valve Position Va “d Dryer A Regneration 01-02-17 1:00
Y | Eterventname orstong match patem  Avg Outlet Temp Eve nt rE ¥4 Dryer A Regneration 0+03-17 2118

¥4 Dryer A Regneration 01-04-17 22:54

Frame data in either
EventFrames  Assets 4 Avg Regen Drum Level Frame %

Summarized or Sampled YR sx | |rtonesrepeenonosiress

structures @ oern & Dryer Processing Age Attrl b utes -« 4 Dryer A Regneration 01.06-17 20:54
uctu @ orers & Max Outiet Temp VR *4 Dryer A Regneration 0+07-17 2106

[=] Max Processed Moisture R ¥4 Dryer A Regneration 0+08-17 22:24

* Sampled view combines s pgenTomp s% Y

f — % Assel Shape *4 Dryer A Regneration U117 02:36
aggreg ations taken over the Attriutes| rer s Qoyera Asset # x|t oneraRegneraton o127 0418

Event Frame duration with O select Al IR E I ement 4% | OverARegrerton 0113170300

*4 Dryer A Regneration 01017 0312

=

] Volecular Sieve Toading o # Outiet Temperature S x “4 Dryer A Regneration 01-14-17 13:30
Asset data sampled at intervals LS 01  bumewnm  Attributeg 7% [0 rwmsmossimas
. » § Outlet Temperature ;] @ Regenerant Tempefibie Sx “8 Dryer A Regneration 01-16-17 2142
throughout the duration pp— 0 3O A egrion 4172330
# Regenerant Flow ;] » “4 Dryer A Regneration 01137 02:24
& Regenerant Return Drum Level e » *4 Dryer A Regneration 01-20-17 06:30
§ Regenerant Retum Drum Pressure (] » 4 Drver A Reaneration 01-21-17 1536
‘ Regenerant Temperature 0 d
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Dryer Regeneration - sampled Event Publication

Interpolated Values — 6 min. Event Frame Attributes\Features

o Dryer Time Stamp Duration Elapsed Time Dryer Pressure  Outlet Temperature  Regenerant Flow  Regenerant Tempe Dryer Regeneration Cycle Avg Outlet Temp  Avg Regen Temp  Dryer Processing Age Total Processed Feed
-
E Dryer A 1/2/2017 12:00:00 AM 53 0 170.4697 436.9 603.2525 496.1 Dryer A Regneration 01-02-17 00:00 3199179 2297132 0.0005072668 4474716
I Dryer A 1/2/2017 12:06:00 AM 5.3 6 170.4524 437.8 603.6448 496.2 « « « « «
Lt Dryer A 122017 12.12.00 AM 53 12 170.495 4386 605.063 496.4 ‘ «
€ [ & 13
— - Dryer A 1/2/2017 12:18:00 AM 5.3 18 170.5076 439.5 599.6411 496.8
@ i 7 “ “
c - B . - - . - . - - . .
(] - - . . . : : “ “ “* ] “*
ﬁ 113 £ 13 13 13
L___|Dryer A 1/2/2017 5:18:00 AM 5.3 318 204.1571 173.8 314.5962 2879
(] | Dryer B 1/2/2017 7:00:00 AM 96 0 169.723 170.2 596.6678 4807 Dryer B Regneration 01-02-17 07:00 357.6974 404.2589 0.05128649 2742962
% Dryer B 1/2/2017 7:06:00 AM 36 6 170.4792 170.3 598.8013 484 8 “ «
13 £ [13
— Dryer B 1/2/2017 7:12:00 AM 9.6 12 171.0217 170.4 597.2024 487.9
u “ £ £ 13 13
—_—
E - . . - - . - . - - . . - . 13 “ “ 1 “
) . . . . . . . “ i 7 “ “
> &
13 [ 13 13
LIJ — | Dryer B 1/2/2017 4:36:00 PM 96 576 168.8051 1749 896.8521 173.8
ry
GE) Dryer A 1/2/2017 7:00:00 PM 1.3 0 169.5046 170 596.4086 4256 Dryer A Regneration 01-02-17 19:00 3325292 364.0818 0.1004348 5302.277
Dryer A 1/2/2017 7:06:00 PM 1.3 6 170.3642 1701 598.5709 4427
(.U “ 13 13 13 &
S Dryer A 1/2/2017 7:12:00 PM 1.3 12 170.2456 170.2 600.7331 466.3
13 13
u & 13 £
—
= . - - . - . - . - . “ 13 “ 13 “
(] - . . - . : : “ 13 “ 13 “
Lﬁ ““ 43 ““ 1 113
| Dryer A 1/3/2017 4:54:00 AM 113 594 167.147 196.4 547.8572 173.4
—
) Dryer B 1/3/2017 8:48:00 AM 93 0 169.3378 170.2 592.8909 4916 Dryer B Regneration 01-03-17 08:48 357.8753 399.4613 0.1699348 6347.083
E Dryer B 1/3/2017 8:54:00 AM 93 6 168.1517 1711 617.2303 490
E DryerB  1/3/2017 9:00:00 AM 93 12 167.7706 205.2 617.502 488.7 “ “ “ “ i
LL _J 113 & 13 £ 13
E - s . " . " . - : - N - . “ “ “ @ “
g - b : : “ 7 @ ‘“ 7
Lu 113 & 13 3 13
—
OSlsoft.
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Diagnostic Analysis - Event Frame Evaluation

« Sampled Event View dataset
imported into Power BI.

* Shows outlet temperature
profiles for all Event Frames
with filters for dryer asset and
cycle duration.

* Filter Event Frames to remove
outliers from analysis.

* Acceptable Regeneration cycle
durations between 7 and 17
hours.

0Slsoft.
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Dryer Regeneration - Additional Feature for Refinement

Determine if total barrels
of feed processed
during the Process cycle
prior to each
regeneration affects
outlet temperature
profile

4560 bbl. 6689 bbl. 5934 bbl. 3493 bbl.

Analysis in Power Bl

0OSlsoft.
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Layers of Analytics — View Thru’ Multiple Lenses

, predictive, prescriptive

 ArchitecCtufeinse: n
- Edge device, Server or cloud

] OSlsoft
K‘ P|WO I‘|d BARCELONA 2018 #PIWorld  ©2018 OSlsoft, LLC
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Predictive and Prescriptive - Shape Metrics — Golden Run

[= Dryer Regenerations.ixt E3 |

1 |Id Dryer TimeStamp.StartTime.Local TimeStamp.EndTime.Local TimeStamp.Local Duration ElapsedTime Dryer Pressure Outlet Temperature Rege
2 1 Dryer A 1/2/2017 12:00:00 AM 1/2/2017 5:18:00 AM 1/2/2017 12:00:00 AM 5.3 0 170.4697 436.9 603.2525 496.1 Dryer A Regnerat
3 2 Dryer A 1/2/2017 12:00:00 AM 1/2/2017 5:18:00 BM 1/2/2017 12:06:00 AM 5.3 6 170.4824 437.8 603.6448 496.2 Dryer A Regnerat
4 3 Dryer A 1/2/2017 12:00:00 AM 1/2/2017 5:18:00 AM 1/2/2017 12:12:00 AM 5.3 12 170.495 438.¢ ©05.063 496.4 Dryer A Regneration 01-C
5 4 Dryer A 1/2/2017 12:00:00 AM 1/2/2017 5:18:00 BM 1/2/2017 12:18:00 AM 5.3 18 170.5076 439.5 599.6411 496.8 Dryer A Regnerat
6 5 Dryer A 1/2/2017 12:00:00 AM 1/2/2017 5:18:00 AM 1/2/2017 12:24:00 AM 5.3 24 170.5202 440.3 604.8259 496.8 Dryer A Regnerat
7 6 e S e S S 2 2 a8 2 600.6193 196.2 Dryer A Regnerat
8 1 b.64  497.2 Dryer A Regneration 01-C
9 8
10 9
-
12 11
13 12
14 13
15 14 400~
16 15
17 16
18 17
19 18
20 19
21 20
22 21 300~
23 22 -
24 23
25 24
26 25
27 26
28 27
29 28 200~
30 29
31 30
32 31
33 32
24 22

100 -

0 50 100 150 0 20 40 60
OSlsoft, Time Time
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450 -

300-

250 -

200 -

Bad Data

50 100
Time

Shape Metrics - Regen Cycles Not OK or Bad Data

Shape Not OK

as.factor(Cycle)
89
92
— 93
— 95
— 103
142
143

150
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Operationalize - Expected Temperature Profile (Prescriptive)

Via Future data tag

411972018 12:54:00 PM - 4/19/2018 3:54:00 PM Event Type: DiyerProfile_OutlefT

Asset: WPISRV01\Dryers\Dryer A
400 -
'_
300~
[ [
t L s L L 1

| 0.5h I . 2.5h
200- 4/19/2018 12:54:00 PM 4/19/2018 3:54:00 PM

0 20 40 60

Time
7 0slsoft
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Shape Metrics - Operationalize the Model

Score the real time Temperature profile data
IS the Temperature profile as expected?
can the difference from ideal be stated quantitatively?
even If dissimilar, did we deliver enough energy?
what false alarms can | avoid?
after an alert, what corrective actions can | take?

‘Acd 3 new variable Evaluate > Fmnctions
‘ Name Expressiocn Value at Evaluatio Value at Last Trig¢ Output Attribute
Insert functions into the expression n
shapeMeasure| IF 'Operating State'="Rege Map |

MATLAB

CurveFitting.calcCurveDistance

7 oSisoit
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Dryer A

Shape Metrics - Operationalize the Model

‘General | Child Elements | Attributesl Ports ‘ Analyses ‘Nutiﬁcali[m RuleslVersiun‘

|

QO0VVD?

Add a new variable

]
2 & =
= H
= fea
- _H (= Reply
A f2Reply All 65
= e . [==2Reply &
]
H | &~ Delete Archive

Delete Respond

Name
IdealData

MATLABEval

If (ArraylLengt

(CurrentData,] The Outlet Temperature profile f|
12:54:00 PM Pacific Daylight Ti
Links:
Deltak
Event Details Hyperlink
DeltaAuC

QTG.
B

(2 Forward [T

pismtprelay@gmail.cd
Dryer A generated a

https://5000vlecs.cloudapp.net/|

T O ;I'I\}|5|o;1
@
@

Events

Automatically refresh the list

< Top
DryerProfile_OutletT 2018-04-19 12:54:00.000

Root Cause
4/19/2018 12:54:00 PM - 4/18/2018 3:54:00 PM

Scheduling: () Event-

-

OSlsoft

PI WO rl d BARCELONA 2018

O Edit Search Criteria

$ °

Root Cause

Event Type: DryerProfile_OutietT

4/19/2018 12.54.00 PM - 4/19/2018 3:54.00 PM Asset: WPISRVO1\Dryers\Dryer A

3 hours into the process

4/19/2018 12:54:00 PM 4/19/2018 3:54:00 PM

Trigger Aftributes (2)

Dryer A Y| Start Value Y | End Value

Dryer A
DellaAUC

Dryer A
DeltaE

Event Attributes (3)
Root Cause

#PIWorld

©2018 OSilsoft, LLC



Layers of Analytics — View Thru’ Multiple Lenses

* Functional Scope - Process Insight & Excellence
» Descriptive, diagnostic, predictive, prescriptive

» Business Scope - Improved Reliability
» Usage-based Maintenance - UbM
* Condition-based Maintenance - CbM

 Predictive Maintenance — PdM
« Simple predictive (Advanced CbM)
» Advanced predictive - Statistical, Machine learning...

"\~ PlWOI’|d BARCELONA 2018 #PIWorld  ©2018 OSlsoft, LLC



Maintenance — Usage and Condition based

» Usage-based Maintenance - UbM

« Motor Run-hours

« Compressor starts/stops
» Transformer — Load Tap Changer — Counts of Operations, Count thru’
Neutral

» Condition-based Maintenance - CbM
* Delta P across a filter

* High bearing temperature

~ * High vibration

7" 0Slsoft. '
#PIWorld  ©2018 OSlsoft, LLC
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Maintenance — Usage based

Eile Search View Go Tools Help

@ Database [ Query Date - (O @ ) Back ) 8, Check in ¥} « [2] Refresh ' J New Element - =] New Attribute

See Pl World 2018
CBM Hand-on Lab

Elements Mixer 1
(% Elements ' General | Child | At Ports | Analyses | Notification Rules | Version |
|- @ Data Archive
% € Exerdse 1 Filter Name lVaMg
| - 6 Process Area Mixer 1|Last Maintenance Date 3/26/2018 12:00:00 AM
- ﬂ Line 1 Lokl K] .
=g e 1] 3 &l cae M|Xer 1 Mixer 1|MTD Run Hours 55.643
- Mixer 2
| - @ u‘-?ezlm ‘0w Mixer 1|Previous Day Run Hours 16.244
- (@ Exercise 2 Fm 5 0 9 Mixer 1|Run Hours Since Maintenance 14.827
(£, Element Searches |
- Mixer 1|Valve Actuation Count Since Maintenance 16
B =l Mixer 1]¥TD Run Hours 55.643
]
=
B =l cate Name Value Units Name Value Units
y 8 Mixer 1|Last Maintenance Date 3/26/2018 12:00:00 AM Mixer 1|Last Maintenance Date 3/23/2018 12:00:00 AM
. Mixer 1|MTD Run Hours 55.143 h Mixer 1|MTD Run Hours 7.5494 h
= Mixer 1|Previous Day Run Hours 16.244 h Mixer 1|Previous Day Run Hours 1] h
8 = Mixer 1|Run Hours Since Maintenanc 14.327 h Mixer 1|Run Hours Since Maintenant 7.5484 h
- Mixer 1|Valve Actuation Count Since 16 count Mixer 1|Valve Actuation Count Since 62 count
B =l cate
e Name Value Urits Name Value Units
L]
Mixer 2|Last Maintenance Date 3/25/2018 12:00:00 AM Mixer 2|Last Maintenance Date 3/24/2018 12:00:00 AM
L]
100 Mixer 2|MTD Run Hours 55.889 h Mixer 2|MTD Run Hours 7.4606 h
] H
- - Mixer 2|Previous Day Run Hours 16.317 h Mixer 2|Previous Day Run Hours 0 h
. - R Mixer 2|Run Hours Since Maintenanc 30.733 h Mixer 2|Run Hours Since Maintenanc 7.4606 h
Mixer 2|Valve Actuation Count Since 34 count Mixer 2|Valve Actuation Count Since 53 count
OSlsoft.
"> PI\World earceLona 2018 #PIWorld ~ ©2018 OSlsoft, LLC




Maintenance — Condition based See Pl World 2018
CBM Hand-on Lab

Eile Search VMiew Go Tools Help
a Database E Query Date -® G 0 Back ) hl( Check In *}) « _ﬂ Refresh '@ New Element - =1 New Attribute

Elemzis Ex2-BearingTemperatureAlerts « Ad Hoc Display
=}- Elements
| |~ (9 DataArchive Number and Duration of High Bearing Temperature Alerts
| +- Exerd:
| o C!SE]. Assel Bearing |4 Count - 7 days  Bearing |/ Count-MTD  Bearing Duration - 7 days  Bearing |4 Duration - MTD ¥
| - ﬁ Exerdse 2 Pump01 320 1100 15.2h 268h
| = (3 Pump Station Pumpod 370 1040 47h 260h
| |- & Pumpo1 Pumpl2 280 58.0 121h 243h
| 1 & Pumpo2 Pump0s 300 900 123h 220h
| Pump03 230 070 arh 196h
I~ 0 Pump03
{— 6 Pumpo4
; L @ Pumpos Watchlist of High Bearing Temperature Alerts
— (£ Element Searches
Event Name A Asset I Start Time | End Time I Reason | By | Date L Acknowledgement
High Bearing Temp_2018-0 . ’
B PUMPO4 32712018 52500 AM 32712018 6:00:00 AM 2 _
High Bearing Temp_2018-0 ) o
Rk PUMPO1 312712018 6:40.00 AM 32712018 715:00 AM 2 _
5 Elements LI S PUMPO1 32772018 7:50.00 AM 32772018 8:30:00 AM 4 _
3-27 07 5000
i~ Event Frames High Bearing Temp,_2018-0
rers PUMP0Z 312712018 75000 AM 2712018 82500 AM 2 _
High Bearing Temp_2018-0 ) . &
T PUMFOS 312712018 50000 AM 32712018 94000 AM _
High Bearing Temp_2018.0
e e BUMPO4 212712018 800,60 AM 2712018 840,00 AM 2 _
High Bearing Temp_2018-0
e PUMPO3 212712018 8:40.00 AM 32712018 10:15.00 AM 4 _
High Bearing Temp_2018-0 ) -
ST PUMPOZ 32772018 11:05:00 AM 32772018 11:30:00 AM 2 _
OSlsoft.
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Maintenance — Predictive — RUL (remaining useful life)

oy [

Bearing Forecasted Failure Date 7/5/2018 8:24:25.795 AM
250 See PI World 2018 Bearing Life Expectancy 2.528
» Yy y
¢ | Hand-on Lab
L
; Name Expression Output Attribute
10 NatlLog if 'OverallBearingFault'>@ then Log('OverallBearingFault') else NoOutput() OverallBearingFault|Natural Log
, Timel2back "F-12w' Map
] f
» M\ f’ JsluLinear“REgr‘ if EnableFit then LinRegr('OverallBearingFault|Natural Log', Timel2back, '*',58) I|Map
\F
L . . .
B Fit if Badval(LinearRegr) Then NoOutput() Else LinearRegr Map
7/16/2004 m if EnableFit AND Not(BadVal(LinearRegr)) then Convert(Fit[1]*24*360@, "gE/day") e!|OverallBearingFaultim
b if EnableFit AND Not(BadVal(lLinearRegr)) then Convert(Fit[2], "gE") else NoOutput |OverallBearingFault/b
rsquared if EnableFit AND Not(BadvVal(LinearRegr)) then Convert(Fit[3],"ratio") else NoOutpi|OverallBearingFault]r squared
LifeExpectancy if EnableFit AND Not(BadVal(LinearRegr)) and m>@ and rsquared>.48@ then Convert((’|BearinglifeExpectancy
ForecastedFailDate if EnableFit AND Not(BadVal(LinearRegr)) and m>® and rsquared>.48@ then TimeStamp |BearingForecastedFailureDate
7 osisoft
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Predictive — Statistical, Machine Learning ...

Predict engine failure — Principal Components - TechCon 2016

100 engines, 20+ sensors per engine, aggregated data per cycle Link
~200 cycles of operation per engine LINK
how long to failure?

Anomaly detection (HVAC - Air Handler) - Support Vectors -TechCon 2017
/ sensors Link
~6 months of operations, 5 minute data
damper stuck open? temperature transmitter failed? air supply fan constraint?

Shape Metrics (profiles of operating variables) - Pl World 2018 Lab

0OSlsoft.
- Pl\World sarceLona 2018 #PIWorld  ©2018 OSlsoft, LLC


https://pisquare.osisoft.com/docs/DOC-3463-predicting-remaining-useful-life-and-equipment-failure-using-a-machine-learning-multivariate-model
https://pisquare.osisoft.com/groups/facilities/blog/2018/01/04/data-sciencemachine-learning-use-case-with-hvac-air-handler

Layers of Analytics — View Thru’ Multiple Lenses

- Functional Scope - Process Insight & Excellence

» Descriptive, diagnostic, predictive, prescriptive

- Business Scope - |mproved Reliability

» Usage-based Maintenance - UbM
* Condition-based Maintenance - CbM

» Predictive Maintenance — PdM
» Simple predictive (Advanced CbM)
» Advanced predictive - Statistical, Machine learning...

ctural Location
evice, Server or cloud based
ing data cpllection? (National Instruments, InsightCM)

77 0Slsoft. .
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OSlsoft Virtual Learning Environment

» Access to the hands-on labs developed for the past st e S S Gy L oy
two Users Conferences (~40) (@ osi. Learning Bt enoty
* Pl Products A—

My Registrations Virtual Learning Classroom Training Online Courses
* Pl System Development | e | vpopiomes | G| oameorm |
Overview

YouTube Learning
Channel

e Condition Based Maintenance
* Analytics with Pl System Data

My Subscription My Session

Yearly
° H t d P I Sy t th M 1 ft A CI d AF SDK Getting Started Guide Manual
oste stem on the IMICroso zure Clou e —
Field Service Scripts Manual
nthly or Yearly Subscription s e
. . . TechCon 2016: Administering and Managing the Pl Server Manual m
ailable to all customers via credit card payment T o

L ‘echCon : Advance el lanual m
0 EA CUStomerS and Dev CIUb Members TechCon 2016: Advanced Programming with PI AF SDK Manual
TechCon 2016: Build Better Reports with PI SQL Framework Manual
TechCon 2016: Build Web-Based Real-Time Dashboards Manual m
TechCon 2016: Collecting Data using the new Pl Connector for UFL Manual m
TechCon 2016: Condition Based Maintenance with Pl AF Manual
TechCon 2016: Developing Cross-platform Mobile Apps Using Apache Cordova and Pl Web AP Manual
TechCon 2016: Downtime Analysis with Event Frames Manual
TechCon 2016: Operational Insights Using Real-time Dashboards and Self-service Business Manual

Intelligence

7 ] OSlsoft.
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THANK YOU!

0Slsoft.
"3 PI\World earceLona 2018

« Gopal Gopalkrishnan, P.E.
gopal@osisoft.com

Solution Architect
OSilsoft, LLC

* Daniele Farris
dfarris@osisoft.com

Enterprise Program Manager
OSlsoft Espana
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Questions? Please rate this session
In the mobile app!

Please wait for
the microphone

DOWNLOAD —
THE MOBILE APP

- Rate sessions and provide feedback &
« Meet and connect with other attendees
OSlsoft

Join the conversation and SHARE PIWorld
what you saw #osisoft #piworld

State your
name & company

# Download on the
¢ App Store

B EBoSQIe Play
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